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ETABS® Version 18.0.1 
Release Notes 

© Copyright Computers and Structures, Inc., 2019 

Notice Date: 2019-06-27 
 
This file lists all changes made to ETABS since the previous version. Most changes do not affect most users. 
Incidents marked with an asterisk (*) in the first column of the tables below are more significant. 

Changes from v18.0.0 (Released 2019-06-17) 

Licensing and Installation 
Enhancements Implemented 

* Incident Description 
* 241938 The version number has been changed to v18.0.1 for a new minor release.  

Frame Design 
Enhancements Implemented 

* Incident Description 
 240624 An enhancement has been made to expand the design details reporting for concrete frame design 

according to the Russian SP 63.13330.2012 code. This includes the following: removal of long-term 
allowable strain limits, updating the subscripts of the epsilon values, identifying the loading type as 
long-term or short-term, removing the duplicate minimum moments from flexural details of 
columns, and adding the tension-side longitudinal rebar area as a basic shear design basis data. 

 242091 The following enhancements have been made to the Russian SP 16.13330.2011 steel frame 
design:  
(1) The program has added a new parameter “Allow Plastic Strain” as a preference item and also as 
an overwrite item which can take a value “Yes” or “No”. This parameter controls which interaction 
equation is to be checked.  (2) The program now determines whether the bending-buckling check 
needs to be performed based on sections SP 16.13330.2011 8.4.4 and 8.4.6 and SP 16.13330.2011 
Table 11.  (3) The program checks the interaction equation Eq.10 of section SP 16.13330.2011 
7.1.5 for only channel sections. This equation was previously checked for all sections.  (4) The 
program no longer checks the interaction equation Eq.109 of section SP 16.13330.2011 9.2.2 for 
box sections. This is still used for all other sections.  (5) The program no longer checks the 
interaction equation Eq.107 of section SP 16.13330.2011 9.1.3 for members with tensile force. This 
is still used for all sections with compression force.  (6) While checking the interaction equation 
Eq.43 of section SP 16.13330.2011 8.2.1, the program now uses Wn,min. For single-symmetric I-
shapes, T-shaped and double angles, Wn,min is the smaller value of Wn between the tension side 
and compression side. For doubly symmetric sections, this change has no effect.  (7) The shear 
areas AvMajor and AvMinor are not recalculated based on the web and flange areas for I, channel, 
box, double channel, and T sections. Previously the areas were slightly different based on the 
corner radius.  (8) The program now reports the values of Tau. This is used in the determination of 
shear-stress ratio (Tau/Rs) which is used in calculating beta and beta_m factors per section 8.2.3 
and in the calculation of cm factors per SP 16.13330.2011 section 8.2.3 and Eq. 53.  (9) The 
program now reports the slenderness (lef/I, or Kl/r) limit related parameters in the database, 
exports, and imports. These were missing in the earlier versions. 
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Analysis 
Incidents Resolved 

* Incident Description 
 240384 An incident was resolved where the potential energy may have been incorrectly reported for models 

where the analysis model for nonlinear hinges was set to "Model Hinges Within Elements" and the 
hinges had significant nonlinear behavior. When this issue occurred, large energy errors were 
reported. This was a reporting error and did not affect other results. 

* 241286 
241431 
241484 
241626 
241645 
241692 
241693 
241704 
241805 
241837 
241881 
241895 

An incident was resolved where analysis results were unavailable when using a Nonlinear license. 
Other license levels (Plus and Ultimate) were not affected. This only affected v18.0.0. 

 241896 An incident was resolved where an access violation was reported while getting shell modal response 
results at the same time as results for other load cases. 

Results Display and Output 
Incidents Resolved 

* Incident Description 
 229844 An incident was resolved where section cuts, story forces, and shell force/stress results at the 

bottom of a wall with a P-M3 wall hinge assigned were incorrect if the Analysis Model for 
Nonlinear Hinges option was set to "Model Hinges Within Elements". This issue did not affect 
models where the Analysis Model for Nonlinear Hinges option was set to "Model Hinges as 
Separate Link Elements". 

 241034 An incident was resolved where in certain displays in DirectX graphics mode the arrow heads were 
missing from the arrows. This was an inadvertent error introduced in v18.0.0. It did not affect 
standard graphics mode. 

External Import/Export 
Incidents Resolved 

* Incident Description 
 240881 An incident was resolved which affected the export of load combinations to Autodesk Revit. The 

load case factors were exported to Revit with an incorrect value of 1 instead of their actual values. 

Application Programming Interface (API) 
Incidents Resolved 

* Incident Description 
 241799 An incident was resolved where, when using the ETABSv17 API in ETABS v18.0.0, the API methods 

cPropMaterial.GetMaterial and cPropMaterial.GetTypeOAPI always returned a zero (0) value for 
parameters which were of type eMatType. This issue did not occur when using the ETABSv1 API. 
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ETABS® Version 18.0.0 
Release Notes 

© Copyright Computers and Structures, Inc., 2019 

Notice Date: 2019-06-12 
 

This file lists all changes made to ETABS since the previous version. Most changes do not affect most users. 
Incidents marked with an asterisk (*) in the first column of the tables below are more significant. 

Changes from v17.0.1 (Released 2018-07-30) 

 

New Product CSiDetail™ 

* Description 

* A new product, CSiDetail™, for creating detailed drawings of concrete and steel structures is being released in 
conjunction with ETABS v18.  
 
Features include: 

• Structural model and designed reinforcement from ETABS 

• Creation of framing plans and schedules for steel frames 

• Creation of framing plans and schedules for composite floors 

• Reinforcing details for concrete beams and columns 

• Reinforcing details for concrete shear wall elevations and cross-sections 

• Customizable detailing rules 

• Customizable user reinforcement in beams and columns 

• Customizable drawing sheets with multiple views 

• Automated bill of quantities 

• Print or export drawings to AutoCAD 

• Export reinforcement details of beams and columns to Revit 
 
One free license of CSiDetail will be available for each valid commercial license of ETABS v17 in effect at the 
time ETABS v18.0.0 is first released. For additional licenses of CSiDetail, please contact CSI Sales. Future 
upgrades of CSiDetail will require a separate Maintenance contract or upgrade fee. 

 

 

 

 

 

 

Licensing and Installation 
Enhancements Implemented 

* Incident Description 

* 240739 The ETABS version number has been changed to v18.0.0 for a new major release. 

 238505 The software and installation have been updated to use the Microsoft .NET Framework 4.7.1.  This 
does not affect the behavior of the software or any results. 
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Loading 
Enhancements Implemented 

* Incident Description 

 217307 
240031 

An enhancement was made to remove the ability to specify multiple angles in the same load 
pattern for auto wind loads based on the AS/NZS 1170.2:2011 code. Older models with multiple 
angles specified will keep the first angle, and new load patterns should be created by the user for 
other angles using the appropriate parameters. The purpose of this change is to better handle 
torsion for multiple directions of wind loading. 

* 234583 An enhancement was made to update the default load combinations for Chinese design codes 
based on recent changes to the National Standard for Reliability of Building Structures. 

Multi-Tower 
Enhancements Implemented 

* Incident Description 

 219249 An enhancement has been made so that a window selection in a model with multiple towers will 
only select items from towers which are tagged to be visible. 

Meshing 
Enhancements Implemented 

* Incident Description 

 221368 An enhancement has been made to significantly improve the speed of creating the analysis model 
if a very large number of previously meshed area objects are modeled that do not need to be 
further meshed. Area objects that are changed, or whose meshing properties have changed, will 
still need to be re-meshed next time the analysis model is created. 

Analysis 
Enhancements Implemented 

* Incident Description 

* 066306 A modification factor for stiffness-proportional viscous damping to be used in direct-integration 
time-history analysis can be specified in the Link Properties Definition form. This modification 
factor is multiplied with the stiffness-proportional damping coefficient defined in the Time-History 
load case to compute the net stiffness-proportional damping coefficient to be used by the link 
element. This can be used to reduce or eliminate stiffness-proportional damping in a link element. 
In addition, the reference stiffness value to be used for stiffness-proportional viscous damping in 
nonlinear direct-integration time-history analyses can be specified for link properties with 
nonlinear degrees of freedom (DOFs). The stiffness options are: the initial stiffness, the tangent 
stiffness, or the effective stiffness of the nonlinear DOFs. To maintain the same behavior as in 
previous versions of the software, set the modification factor to unity and use the initial stiffness 
for stiffness-proportional viscous damping. This is still the default. 

* 229433 Nonlinear static analysis, including staged-construction, has been enhanced to allow the use of line 
search and event-stepping at the same time. Previously only one of these two options could be 
used for a given load case, and event-stepping took precedence. Now, when both options are 
selected, event stepping will be used for the first iteration, and line search will be used for 
subsequent iterations. By default, events and iteration without line search will be enabled for 
newly created load cases, which is equivalent to the previous behavior. When opening existing 
models from a previous version, load cases that had both options enabled will have the line search 
turned off to reproduce the previous behavior. Note that line search is never used for load cases 
that use event-stepping only, i.e., that have iteration turned off. Note also that line search is never 
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* Incident Description 

used for nonlinear static load cases under displacement control, only for load cases under force 
control. Staged construction load cases always use force control. 

* 018263 Rotational degrees of freedom will no longer be generated for frame (line) objects that represent 
truss members. Previously these zero-stiffness rotational degrees of freedom could generate 
instability warnings during analysis, even though the accuracy of the solution was not affected 
unless moment loads or rotational moments of inertia were applied at these degrees of freedom. 
A frame object is now automatically determined to be a truss member if (1.) End releases are 
assigned for moments M2 and M3 at both ends and for torsion at either end, (2.) The end offsets 
are zero at both ends, and (3.) The insertion points at both ends are at the centroid with no joint 
offsets. Note that a truss member may still exhibit internal bending moments due to transverse 
loading, including self-weight, but no moments will be transferred to the structure at the two ends 
of the member. 

 223578 The size of the saved analysis results files has been reduced for multi-step nonlinear static and 
nonlinear direct-integration time-history load cases using the None or P-Delta geometric nonlinear 
options. This will reduce the amount of disk space required for these types of load cases in models 
containing frame, shell, and link elements. This may also result in some speed increase when 
running the analysis and displaying results, particularly for load cases with many steps. Results are 
not affected. 

 223655 A new option has been added when specifying viscous proportional damping for time-history and 
response-spectrum load cases where the mass- and stiffness-proportional coefficients can be 
calculated during analysis to provide specific modal damping ratios at frequencies or periods that 
are relative to a given mode of the structure. Viscous proportional damping is always used for 
direct-integration time-history, and can be used as an option for modal time-history and response-
spectrum load cases. 

* 240736 The stiffness to be used for the nonlinear degrees of freedom (DOF) of link elements when running 
linear load cases can now be specified with more control. Previously the linear effective stiffness 
was always used for linear load cases starting from zero initial conditions, and the actual nonlinear 
stiffness existing at the end of a nonlinear load case was always used for linear load cases 
continuing from that load case. Now the following stiffness options are available for each 
nonlinear link property: (1.) “Effective stiffness”, (2.) “Nonlinear stiffness”, or (3.) “Effective 
stiffness from zero, else Nonlinear”. The first option is most suitable for isolators where mode 
shapes and damping are to be calculated based on a specified secant stiffness, regardless of any 
preceding load case. The second or third options are more appropriate for gaps and other link 
properties where previous conditions do affect mode shapes, damping, and other linear behavior. 
When “Nonlinear stiffness” is chosen, the initial nonlinear stiffness is used rather than the 
effective stiffness for linear load cases starting from zero. This value is taken as zero for viscous 
dampers. To maintain the same behavior as previous versions of the software, use “Effective 
stiffness from zero, else Nonlinear”, which is still the default. Note that geometric nonlinearity 
effects (P-delta and large deflections) are always included from a preceding nonlinear load case 
regardless of the option chosen. Linear link properties and linear DOF of nonlinear link properties 
are not affected by this enhancement. 

* 229428 Convergence behavior of the tension-compression friction-pendulum isolator link element has 
been improved, particularly to deal with large variations in the axial force, which can cause 
alternating slip-stick behavior during lateral loading. Models that exhibited slow convergence 
behavior in previous versions should be re-run in the new version to verify the results. The new 
results will be more accurate in cases where a significant difference is observed between the old 
and new results. Furthermore, the friction model has been changed from the previous Wen 
formulation that exhibited a gradual transition between sticking and slipping to a bilinear model 
that exhibits a sudden transition. Some difference in results can be expected due to the new 
formulation, particularly for models where the initial stiffness specified for the isolator was small. 
Similar changes were made to the formulations of the friction-pendulum and triple-pendulum 
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* Incident Description 

isolator link elements in previous releases of the software. Finally, the new formulation supports 
event stepping, which can be used as part of the iteration and stepping strategy specified for 
nonlinear static, staged-construction, and nonlinear direct-integration time-history load cases. 

Frame Design 
Enhancements Implemented 

* Incident Description 

 212000 An enhancement has been made to the concrete frame design code “NZS 3101-06” in which the 
torsion design of beams has been incorporated based on NZS 3101-06 Amendment A3. 

 215319 An enhancement was made to include slightly inclined columns when calculating the frame shears 
used to calculate Frame Shear Ratios in Dual Frame-Shearwall systems. This affects frame 
modifiers when designing for seismic loads based on the Chinese code. Earlier only vertical frame 
members were considered for this shear calculation. Now any member that satisfies the definition 
of column will be included in the calculation. This is controlled by the command Options > 
Tolerances > Maximum Inclination from Vertical for Columns (degrees). The frame shear will use 
the horizontal component of the force carried by the inclined column, which may include a small 
fraction of the axial load. 

 234084 An enhancement was made to improve the Design Details window for concrete frame design to 
show only those tabs that are applicable to the particular design code. Previously all available tabs 
were visible, even though some of the tabs did not display results for certain codes. This was a 
display issue only. No results were affected. The Design Details window is accessed by right-clicking 
on a frame member while viewing concrete frame design results on the model, then clicking the 
Details button on the resulting form. 

 220215 An enhancement was made to speed up frame and wall design for all design codes and materials 
when considering many load combinations containing load cases with multi-stepped results and 
when step-by-step design was requested. Examples of such cases include linear and nonlinear 
static load cases with multiple wind or seismic load directions, and time-history load cases. No 
results are affected. 

* 226392 An enhancement was implemented to add the new Turkish TS 500-2000(R2018) concrete frame 
design code, including seismic design requirements.  

* 226393 An enhancement has been implemented to add concrete frame design for the Mexican Building 
Code (Mexico RCDF 2017). 

* 226394 An enhancement has been implemented to add the new Australian AS 3600-2018 concrete frame 
design code.  

* 226395 An enhancement has been implemented to add the new Korean KBC 2016 concrete frame design 
code, including seismic design requirements.  

* 226396 An enhancement has been implemented to add the new Korean KBC 2016 steel frame design 
code, including seismic design requirements. 

* 101845 
102237 

An enhancement has been made to the Russian concrete frame design code “SP 63.13330.2012” 
to include crack-width analysis for concrete beams. 

* 228114 An enhancement has been made to the Russian steel frame design code SP 16.13330.2011 in 
which the interaction equation as stated in equation (44) of section 8.2.1 is now being checked as 
a PMM interaction equation. This involves the determination of elastic normal and shear stresses, 
calculation of the von-Mises stress, and then checking the von-Mises stress with 
(Ry*Gamma_C)/0.87. The results are now reported in the details window as a separate page for 
“Equivalent Stress Check Details”. 
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* Incident Description 

 228115 An enhancement has been made to expand the design details reporting for concrete frame design 
according to the Russian SP 63.13330.2012 code. This includes the following: removal of long-term 
allowable strain limits, updating the subscripts of the epsilon values, identifying the loading type as 
long-term or short-term, removing the duplicate minimum moments from flexural details of 
columns, and adding the tension-side longitudinal rebar area as a basic shear design basis data. 

 228117 An enhancement has been made to steel frame design per the Russian code SP 16.13330.2011 in 
which the program now allows additional input parameters for the slenderness limit check for 
compression and tension members per SP 16.13330.2011 section 10.4.1 and Tables 32 and 33. For 
compression members, the limit for slenderness ratio KL/i (or Lambda = lef/i) is taken as follows: 
Lambda < KLoverRLimitC -  KLoverRLimitSlope * Alpha, where Alpha = max 
{N/(Phi*A*Ry*Gamma_c),  N/(Phi_e*A*Ry*Gamma_c),  0.5}. The program allows input for 
KLoverRLimitC and KLoverRLimitSlope in the overwrites. By default, the program takes the value of 
KLoverRLimitC as 180 for columns, 210 for braces, and 200 for beams; and takes the value of 
KLoverRLimitSlope as 60 for columns, 60 for braces, and 0 for beams. For tension members, the 
limit for slenderness ratio l/i (or Lambda) can be assigned one value in the overwrites. The default 
value for the limit for slenderness ratio l/i is taken as 300 for columns, 400 for braces, and 300 for 
beams. 

 228118 A change was made in concrete frame design per the Russian “SP 63.13330.2012” code on how 
load combinations are to be tagged (identified) as being for long-term loading. Previously all load 
combinations that had lateral loads (seismic or wind) were tagged as short-term, and all the 
remaining combinations were tagged as long-term. Now those load combinations that contain only 
sustained load are identified as long-term load combinations. All dead load and superimposed 
dead load cases are considered sustained. All wind load and earthquake dead load cases are 
considered short-term. All live load cases will be considered as sustained if the “Live Load Duration 
Factor” is 1.0. If the “Live Load Duration Factor” is less than 1.0, any combination involving live 
load will not be considered as long-term. Similarly, all snow load cases will be considered as 
sustained if the “Snow Load Duration Factor” is 1.0. If the “Snow Load Duration Factor” is less than 
1.0, any combination involving snow load will not be considered as long-term. These two 
parameters can be modified in the Design Preferences. Tagging a load combination as short-term 
or long-term affects the factor Gamma_b1, which in turn affects the design values of the 
compressive and tensile resistance of concrete, Rb and Rbt. In addition to this change, the 
“Gamma_b1 Short Term” parameter is removed from the Design Preferences values as this value 
must always be 1.0 (unity). The value of Gamma_b1 is now reported in the design details output. 

 228121 An enhancement has been made to steel frame design per the Russian code SP 16.13330.2011 in 
which the program now considers an additional parameter for seismic factor, m_tr, per Table 6 of 
SP 14.13330.2014 when the design load combination contains an earthquake load case. For 
strength design/check, its value is taken as 1.3. For buckling design/check, it is taken as 1.0 for 
steel frame members with slenderness more than 100, 1.2 for steel frame members with 
slenderness less than 20, and interpolated between 1.2 and 1.0 for steel frame members with 
slenderness ratio between 20 and 100. This value cannot be modified by the user using the 
preferences or overwrites. 

 228123 An enhancement has been made to steel frame design per the Russian code SP 16.13330.2011 in 
which the program now allows an additional input parameter for the reliability factor, Gamma_n, 
in the Preferences form. Its default value is taken as 1.0. However, the user can change it to any 
positive value they want. By increasing the criticality safety factor Gamma_n, the design force 
values are practically increased. The PMM interaction ratios are directly related to this factor. 
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* Incident Description 

 228125 An enhancement has been made to the Russian steel frame design code SP 16.13330.2011 in 
which several preference and overwrite items have been removed from the Preferences and 
Overwrites forms. These include “Framing Type”, “Section Class”, and “Live Load Limit, L/” from 
the Steel Frame Design Preferences form. These also include “Framing Type”, “Section Class”, “Live 
Load Limit, L/”, “Live Load Limit, Abs”, “Effective Length Factor Braced (K1) Major”, and “Effective 
Length Factor Braced (K1) Minor” from the Steel Frame Design Overwrites form. All of these 
parameters were not used in the design. The corresponding items have been removed from the 
API and Database. 

* 234426 A change has been made to remove certain older design and loading codes. The old loading codes 
were inconsistent with the newer design codes which assume ultimate-level wind and seismic 
loading. Specifically: 
(1.) Superseded code CSA A23.3-04 for concrete frame, shear wall, and slab design is no longer 
supported, and this will be replaced by the CSA A23.3-14 code if existing models are opened and 
re-run in the new version. 
(2.) Superseded code CSA S16-09 for steel frame and composite beam design is no longer 
supported, and this will be replaced by the CSA S16-14 code if existing models are opened and re-
run in the new version. 
(3.) Superseded auto seismic loads for BOCA 1996, UBC 94, UBC 97 and UBC 97 Isolated are no 
longer supported, and these will be replaced by the ASCE 7-16 load if existing models are opened 
and re-run in the new version. 
(4.) Superseded response spectrum functions for BOCA 1996, UBC 94 and UBC 97 are no longer 
supported, and these will be replaced by the ASCE 7-16 response spectrum function if existing 
models are opened and re-run in the new version. 
(5.) Superseded auto wind loads for BOCA 1996, UBC 94 and UBC 97 are no longer supported, and 
these will be replaced by the ASCE 7-16 load if existing models are opened and re-run in the new 
version. 
Users should check that the loading and design parameters are correct for their purposes for any 
converted codes. 

 236676 An enhancement has been made to concrete frame design for those codes where column design 
requires a beam-column capacity check for seismic design. The column moment is now checked 
for capacity in one direction (major or minor) at a time, using the axial load from each considered 
design combination, and while taking the moment in the other direction as zero. In addition, this 
check is only performed for moment directions which have significant moment for that design 
combination. Previously it was being checked for both major and minor direction moments 
simultaneously for each design combination axial load, which was overly conservative. Affected 
codes are “ACI 318-14”, “ACI 318-11”, “ACI 318-08”, “AS 3600-2018”, “AS 3600-09”, “CSA A23.3-
14”, “Eurocode 2-2004”, “IS 456:2000”, “Italian NTC 2008”, “KBC 2016”, “KBC 2009”, “Mexican 
RCDF 2017”, “Mexican RCDF 2004”, “TS 500-2000”, and “TS 500-2000(R2018)”. 

Composite Beam Design 
Enhancements Implemented 

* Incident Description 

* 055121 Composite beam design per the AISC 360-16 code has been enhanced so that axial forces can be 
taken into account for design. This new option can be activated on a model-wide basis in the 
Composite Beam Preferences, or on a beam-by-beam basis in the Composite Beam Overwrites. 
The option is turned off by default, meaning that existing composite beam designs are not 
affected. Additional information on this option is available in the revised Composite Beam Design 
Manual for AISC 360-16. 
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* Incident Description 

 221196 Three enhancements have been made to the design reports generated for composite beams that 
feature web openings:  
(1.) If the user provides reinforcing plates at an opening, the aspect ratio of these plates is 
reported as well as the maximum value of that ratio satisfying the plates’ compactness 
requirements.  
(2.) If reinforcing plates at an opening are not compact, an explicit message referring to the plates 
is now provided instead of a generic message referring to the overall beam section.  
(3.) If the beam is designed assuming composite action, the interaction ratios for each opening are 
reported for construction conditions and service conditions in both the interactive design form and 
in the output. Previously, a single interaction ratio, the most critical one of these two, was 
reported at each web opening. 

 221321 Several enhancements have been made to composite beam design per Eurocode 4-2004, referred 
to as EC4 in the following: 
(1.)  In accordance with EC4 Clause 5.4.2.1(5), the effective widths of composite beams are now 
limited to a fraction of their lengths Le between points of zero bending moment. In previous 
versions of ETABS, the effective widths were limited to a fraction of the beam spans. Note that in 
the case of simply supported beams, the most common case, the two lengths are the same. 
(2.) In accordance with EC4 Clause 5.5.2(3), ETABS computes the design resistance moment of 
sections that have webs in class 3 and flanges in class 1 or 2 as effective cross-sections in class 2, 
with their effective web areas reduced per EC3-1 Clause 6.2.2.4. 
(3.) In accordance with EC4 Clause 6.2.1, the design resistance moment of composite beams is now 
reduced when the grade of steel is S420 or higher. 
(4.) The minimum percentage of composite action is now the lowest of the percentages specified 
in EC4 Clause 6.6.1.2 and in SCI NCCI: Modified Limitations on Partial Shear Connection in Beams 
for Building PN002a-GB - referred to as PN002a in the following. 
(5.) In accordance with EC4 Clause 6.6.1.3, ETABS displays warning messages in the Interactive 
Composite Beam Design form and in the composite beam design output when the plastic 
resistance moment of the composite section exceeds two and a half times the plastic resistance 
moment of the steel section alone.  
(6.) In accordance with EC4 Clause 5.4.2.2 (11), in order to account for the effects of concrete 
creep and shrinkage, the value of the transformed moment of inertia of the composite section is 
now computed using Ec = 0.5 Ecm, where Ecm is the modulus of elasticity specified in the concrete 
properties. The value of the 0.5 factor can be changed in the composite beam design preferences 
and beam overwrites. 
(7.) ETABS now ignores the effect of partial composite action on beam deflections when the 
conditions for ignoring it set forth in EC4 Clause 7.3.1(4) are satisfied, and computes beam 
deflections per PN002a otherwise.  
(8.) In accordance with EC4 Clause 7.3.1, ETABS now takes into account the deflection caused by 
concrete shrinkage when applicable. 
(9.) In accordance with SCI Publication 359: Composite Design of Steel Frame Buildings, ETABS 
checks that the flexural stresses remain in the elastic range under un-factored service loads. 
(10.) When a beam frames into a column or wall and is not coped, ETABS computes its shear 
capacity at the ends (which is the reported shear capacity) per Eurocode 3 Clause 6.2.6(3)a. 
Previously, it computed the shear capacity as the product of its section depth by its web thickness 
which was more restrictive than Eurocode 3 Clause 6.2.6(3)a. 
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* Incident Description 

* 225308 Composite Beam Design has been enhanced to now consider two new types of steel sections: 
castellated sections and cellular sections. While castellated and cellular sections can be assigned to 
any frame object, sections of these types can only be designed if: (1) the selected composite beam 
design code is the “AISC 360-16” code, and (2) the design procedure assigned to the beams is the 
Composite Beam Design procedure. Castellated and cellular beams are then designed per the 
Provisions of AISC Design Guide 31: Castellated and Cellular Beam Design, as documented in the 
ETABS Composite Beam Design Manual AISC 360-16. Four Verification Examples are provided 
based on the design examples published in the Design Guide 31. 

 235872 An enhancement was made to composite beam design for all design codes: When the user selects 
construction stress ratios, final stress ratios, live-load deflection ratios, or total load deflection 
ratios in the Display Composite Beam Design Info form, the colors of the beams in the current 
display window now reflect the values of the selected ratio. If instead the user selects “Labels” or 
“Design Data” in the Display Composite Beam Design Info form, the colors of the beams reflect the 
values of the beams’ most critical ratios. Previously the color of the beams was always based on 
the critical ratio regardless of the selected option. In addition, the Display Composite Beam Design 
Info form now features three new options: an option for displaying bottom flange stress ratios, an 
option for displaying vibration check ratios, and an option for displaying shear-stud crowding 
ratios. When one of these options is selected, the colors of the beams reflect the values of the 
corresponding ratio. 

Shear Wall Design 
Enhancements Implemented 

* Incident Description 

 088315 An enhancement was made to change design defaults for shear wall design to be step-by-step for 
load combinations that include a multi-response load case. The old default was to use enveloped 
forces for design. This new default makes shear wall design consistent with concrete frame design. 

* 100052 An enhancement was made to add shear wall design based on the Russian SP 63.13330.2012 code. 

* 229660 An enhancement was made to change the method of tracing wall legs in 3D walls. Now co-planar 
wall legs are no longer broken at intermediate cross walls. If the user wants to break them at the 
cross walls, this can be done by giving the walls on either side of the cross wall different pier 
assignments. 

* 236964 Shear wall design has been implemented for the new Australian AS 3600-2018 code. 

* 236965 Shear wall design has been implemented for the new Korean KBC 2016 code, including seismic 
design requirements. 

* 236966 Shear wall design has been implemented for the new Mexican Building code (Mexico RCDF 2017), 
including seismic design requirements. 

* 236967 Shear wall design has been implemented for the new Turkish TS 500-2000(R2018) code, including 
seismic design requirements.   

 225857 An enhancement has been made for concrete shear wall design per code “Chinese 2010” where 
the design details for spandrels has been reorganized for clarity. No results are affected. An 
enhancement was also made to update the overwrites for spandrels to include the clear cover at 
the left and right for both top and bottom. 

Slab Design 
Enhancements Implemented 

* Incident Description 

* 217324 
218900 

Concrete slab design is now available for the Russian SP 63.13330.2012 code. 
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Results Display and Output 
Enhancements Implemented 

* Incident Description 

* 101228 An enhancement has been made to add deformation, shear, and rotation gauges. Line and quad 
gauges can be defined and acceptance criteria specified. Tabulated results can be obtained for the 
strain gauges for different linear and nonlinear load cases. This option is only available at the 
ETABS Ultimate level. 

 220832 The command File > Create Video has been enhanced to check if the selected compression option 
(codec) for creating AVI files will work on the user’s machine, and inform the user if it will not. 

 222052 
226388 
228796 

An enhancement has been made to add auto seismic loading and corresponding auto seismic load 
calculations to the Project Report for the ASCE 7-16, NBCC 2015, KBC 2016, and TSC-2018 codes. 

* 224289 
230486 

An enhancement has been made to display load combination results on a step-by-step basis for 
linear load combinations of load cases that may contain one or more stepped load cases. Both on-
screen display and tabulated results are now available. Max/min results were always available. 
Design is not affected as it already had the option for step-by-step design.  

* 012706 
082048 

An enhancement has been implemented to the response output for Generalized Displacements. 
Absolute and relative displacements, velocities, and accelerations will be available for all 
Generalized Displacements and results presented in the tables. 

* 234806 The display of results from modal time-history load cases, including FNA, has been made faster for 
large models. This improvement will most notably affect modal time-history load cases using a 
large number of modes for models with a large number of joints. Speed will be improved for the 
graphical display of displacements, forces and stresses, section cuts, and other response 
quantities; for creating videos; for producing tabular output; and for running design. The speed up 
will be most noticeable for individual steps. The effect for envelopes will be less pronounced. 

Graphics 
Enhancements Implemented 

* Incident Description 

 079632 An enhancement was made so that the command View > Restore Full View will now scale and 
center the view to include only the visible grid systems, in addition to the structure itself. 
Previously the full view included hidden grid systems, even if they were far from the structure. 

 233487 
233981 

An enhancement has been made to display floor loading as contours. This display is available in 
plan view and will display the cumulative uniform and non-uniform distributed load applied in a 
load pattern. 

Database Tables 
Enhancements Implemented 

* Incident Description 

* 053244 
218309 
219138 

An enhancement has been made to add a new set of database tables that allow significantly better 
interactive editing capability (similar to other CSI programs, such as SAP2000 and SAFE). Export 
and import of models using tables in Excel, Access, Text, or XML format is also now supported. 
Some table names and field names have been changed to provide more consistency. Named Sets 
of tables can be defined for repeated selection of tables used for editing, display, or export. The 
existing text model file (.E2K, .$ET) has been retained. 

 220244 An enhancement was made to add the minimum rebar required by code to the slab strip design 
summary table. This was already available in the detailed table on a station-by-station basis and 
now has been added to the summary table. 
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External Import/Export 
Enhancements Implemented 

* Incident Description 

 080613 A minor enhancement was made to export displayed tabulated reactions to CAD (DXF/DWG) or 
PDF formats as tables when using the command File > Capture Picture. This is a formatting change 
only; the exported data has not changed. This option to display tabulated reactions is only 
available in Standard Graphics mode, so the export from DirectX mode has not changed. 

 227829 When creating a shell object from a .DXF file using the command Draw > Draw Floor/Wall Objects 
> Import User Mesh as Shell Object, warning messages are now provided when one or more of the 
imported mesh elements has an illegal shape and has been discarded. Illegal shapes include 
elements whose corners are coincident, edges are colinear or cross each other, or whose area is 
too small. Such illegal elements were previously discarded without warning. Legal elements are 
retained as before, but the resulting shell object may have holes in it, and it should be checked for 
suitability before being used for analysis and design. 

Application Programming Interface (API) 
Enhancements Implemented 

* Incident Description 

 203537 
232255 

The Application Program Interface (API) was enhanced for speed for the following functions in 
SapModel.cAnalysisResult used to retrieve analysis results: AreaStressShellLayered, 
AreaStrainShellLayered, AssembledJointMass, FrameForce, FrameJointForce, GeneralizedDispl, 
LinkDeformation, LinkForce, LinkJointForce, PanelZoneDeformation, PanelZoneForce, 
SectionCutAnalysis, and SectionCutDesign. A minor correction was also made for the programming 
example provided in the Help file for the AreaStressShellLayered function. 

* 221919 The Application Programming Interface (API) has been updated from ETABSv17 to ETABSv1. The 
new API is designed to be compatible with future versions of ETABS (v19, etc.) and cross-
compatible with other CSI products. The new cross-product interface, called CSiAPIv1, will work 
with ETABS, SAP2000, and CSiBridge, although not all functions will be implemented for every 
product. These interfaces will maintain compatibility with older versions of the product until a 
major breaking change is made to the entire cross-product system. Any client programmed against 
ETABSv1 will also work with CSiAPIv1. Clients previously programmed against the ETABSv17 
interface should work with ETABSv1 after simply recompiling to reference the new interface. 

* 238396 An enhancement was made to the Application Programming Interface (API) so that all database 
tables are now available for output. Functions are provided to request the contents of any table, 
with options to control which columns are output. Load patterns, load cases, and load 
combinations to be included in the tables can be controlled, as well as the type of output results 
(Envelope, Last Step, etc.). Available output formats include an array of values, a CSV file or string, 
or an XML string. An additional function is provided to display a set of tables in Excel, provided that 
Excel is installed on the same machine as ETABS. These functions are available in the new API class 
cDatabaseTables. All tables are presented in the consistent units set as the current units using the 
API. 

* 238396 An enhancement was made to the Application Programming Interface (API) so that all importable 
database tables are now available for editing. Functions are provided to request the contents of 
any set of editable tables, with each table formatted as an array of values, a CSV file, or a CSV 
string. Additional functions are provided to update the model from these tables after modification. 
This feature behaves similarly to interactive database editing that is available in the graphical user 
interface. These functions are available in the new API class cDatabaseTables. 
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Documentation 
Enhancements Implemented 

* Incident Description 

 221014 The composite beam design manual for the CSA S16-14 code has been revised for clarity, and is 
now consistent with the composite beam design manuals for the AISC codes. Composite beam 
design results are not affected by this change except as may be documented under other 
incidents. 

 221322 The composite beam design manuals for the Eurocode 4-2004 code has been revised for clarity, 
and are now consistent with the composite beam design manuals for the AISC codes. Composite 
beam design results are not affected by this change except as may be documented under other 
incidents. 
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Drafting 
Incidents Resolved 

* Incident Description 

 100098 An incident was resolved where extrusion of lines to areas would not work correctly in certain 
cases. When this happened the error was obvious. Results agreed with the model as generated. 

 201241 An incident was resolved where the Drawing Control Type, once set to an applicable value for 
drawing one type of object (say frames), sometimes remained set to that value when drawing a 
different type of object (say floors), even if the value was not applicable.  This could make drawing 
the second type of object difficult, but could be resolved by returning to drawing the first type of 
object and setting the Drawing Control Type to “None”. 

 201288 An incident was resolved where certain editing options for walls, including on-screen reshaping, 
would not work correctly after their local-3 axes had been reversed using the command Edit > Edit 
Shells > Reverse Wall Local 3 Axis.  Results agreed with the model as edited. 

 215440 An incident was resolved where moving joints in one part of the structure was causing tendon 
profiles to be lost in a model even though the joints were not connected to the tendons.  This 
happened when the tendon profiles were being recalculated, but the original strips referenced for 
drawing the tendons had been deleted.  The tendon profiles are now no longer recalculated if the 
joints moved are not connected to them. 

 216037 An incident was resolved where the option to have pier names automatically assigned did not 
work when creating walls from an architectural plan. 

 217327 An incident was resolved where objects drawn in a 2D view (plan or elevation) did not always 
appear in 3D views until the 3D views were manually refreshed.  This issue only affected DirectX 
graphics mode. 

 228994 An incident was resolved where an abnormal termination would occur when trying to add a 
template model to an existing model with no gridlines in the grid system.  Adding from a template 
requires at least two gridlines in each direction to work.  The condition is now detected and an 
error message is provided to the user so that it can be corrected before allowing the operation to 
proceed.  The affected menu command is Edit > Add to Model from Template. 

 225133 An incident was resolved where, in certain particular cases, the Replicate command was adding 
duplicated joints.  This was a very rare occurrence and typically occurred before saving the model 
after starting with a blank model. 

 233510 An incident was resolved where the option to add grids via the menu command Edit > Edit Stories 
and Grid Systems ... “Add from dxf/dwg File” was only intended to work from dxf files.  The 
command name has been corrected to “Add from dxf File” to avoid confusion. 

 233603 An incident was resolved where architectural layers used as reference for building the model 
would not be correctly adjusted when a story was deleted, causing the architectural layers to 
disappear or to be associated with the wrong stories.  No results were affected. 

Modeling 
Incidents Resolved 

* Incident Description 

 088801 An incident was resolved where the centroid was not correct for hat-shaped, cold-formed steel 
frame sections.  For such sections, analysis and design results could be incorrect, but agreed with 
the location of the centroid as shown. 

 202780 
212302 
214809 
218283 

An incident was resolved where nonlinear hinges could not be assigned to wall objects after their 
local-3 axes had been reversed using the command Edit > Edit Shells > Reverse Wall Local 3 Axis. 
When this occurred, an error message was given and the hinge assignment did not take effect. 
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* Incident Description 

 219900 An incident was resolved where a frame member that was assigned a frame section property of 
type buckling-restrained brace (BRB), including CoreBrace BRB properties, was not using the BRB 
features if the member was classified as a beam rather than a brace.  This would be the case if the 
angle of the member with respect to the horizontal plane was less than the brace tolerance, 
typically 20 degrees.  When this happened, the member used the underlying section property and 
ignored the additional BRB features.  In addition to the effect on the behavior of the model, this 
could also generate an error message when displaying the table of frame members assigned 
CoreBrace BRB section properties.  Now, all inclined members assigned BRB properties will use the 
full BRB features.  However, horizontal members will still ignore the additional BRB features. The 
tolerance for horizontality is that the sine of the angle of inclination be 0.01 or less. 

 229424 An incident was resolved where, in rare cases, exporting and then importing a model using the text 
file (.E2K, .$ET) would cause user-defined notional sizes of concrete members used for time-
dependent creep and shrinkage calculations to not be applied correctly.  When this occurred, 
results agreed with the model as imported. 

 238127 An incident was resolved where the yield moment for nonlinear hinges in a concrete frame 
member may not have been calculated correctly if the section was originally a T section, but was 
later modified in the Frame Section Property Data form to become a rectangular beam.  In such a 
case, the width of the beam was not properly used to calculate the hinge properties.  This did not 
affect rectangular frame sections or T sections that were not converted to rectangular. 

Section Designer 
Incidents Resolved 

* Incident Description 

 221770 An incident was resolved where an error message was generated when saving the text file if the 
model contained a Section Designer section that had a circular rebar pattern where only the tie 
bar information was given, but no longitudinal rebar size or area was given. 

 231293 An incident was resolved where in some instances the CG Offsets shown in the Frame Section 
Properties form were not correct for Section Designer sections.  No results were affected, and this 
was only a display issue in that form.  This would occur when the geometric center of the section 
bounding box did not coincide with the origin of the x-y coordinate system in Section Designer and 
the 2-3 axes of the section were rotated with respect to the x-y axes.  The CG Offsets are measured 
from the geometric center of the bounding box to the centroid.  No other section property values 
were affected. 

Loading 
Incidents Resolved 

* Incident Description 

 207741 An incident was resolved where the joint pattern information shown when right-clicking on area 
(shell) objects did not provide the option to select “Zero positive values” from the drop-down list. 
Instead the option “Zero negative values” was presented twice.  Results were not affected. 

 218412 An incident was resolved for the NBCC 2015 auto seismic load case where parameter Mv was not 
saved when changed on the form and instead it defaulted back to its original value.  The error was 
evident from the auto seismic table and the seismic report, and results were consistent with the 
default value. 

 220945 
222148 
228158 

An incident was resolved where, for certain models, an error condition would occur when calculating 
torsional loads due to accidental eccentricity for a response spectrum analysis.  This happened when 
there were one or more stories in the model that had no joints.  Now such stories will be ignored 
without error. 
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* Incident Description 

 222347 An incident was resolved for the ASCE 7-16 response spectrum function where coefficients Fa and Fv 
were not allowed to be overwritten by the user for Site Class E in cases where they should be site 
specific. 

 223867 An incident was resolved where in the ASCE 7-05 Auto-Seismic Loading form the options for 
selecting coefficients “Ct” and “x” for Time Period options “Approximate” and “Program Calculated” 
were always being reset to the first option “0.028, 0.8” regardless of user choice.  This form is 
accessed using the menu command Define > Load Patterns > Modify Lateral Load for load patterns 
of type Seismic and with Auto Lateral Load set to ASCE 7-05.  Results were consistent with the values 
of “Ct”, “x” = “0.028, 0.8”.  No other codes were affected. 

 228400 An incident was resolved where time-history functions of the type “Matched to Response Spectrum” 
would generate an error when later viewed or edited if that function referenced a user-defined 
response-spectrum or time-history function, and either of those functions was subsequently 
deleted.  Now user-defined response-spectrum or time-history functions that are referenced by a 
“Matched to Response Spectrum” function are protected from deletion. 

 236042 An incident was resolved where time-history functions defined to match to a response-spectrum 
curve could not be generated when the source response-spectrum function had more than 400 
points.  The upper limit on the number of points has been reduced to 200 for reasons of efficiency, 
but now response-spectrum functions exceeding that limit will be simplified by interpolation before 
being used to generate matched time-history functions.  Practical response-spectrum curves with a 
reasonably smooth shape will not be affected by this process. 

 225639 An incident was resolved where the PhiZ parameter in Chinese Wind Load calculations was not 
correctly interpolated from the mode shape, when it was specified to be taken from mode shapes, if 
the Bottom story specified for exposure was not at zero elevation. 

Multi-Tower  
Incidents Resolved 

* Incident Description 

 058268 An incident was resolved where Quick-Draw wall objects for multi-tower models were always 
being assigned to Tower 1 if the auto-tower option was selected.  Now the walls will be assigned to 
the correct tower based on the grids used for the Quick Draw operation. 

 059250 An incident was resolved where using the arrow buttons to move up and down the stories when 
displaying a plan view would sometimes cause an error condition to occur in multi-tower models. 
Results were not affected. 

 062048 An incident was resolved where in a multi-tower model, some frame elements were not being 
auto-meshed at intermediate joints, leading to disconnected models.  This particularly could affect 
the connection of secondary beams to primary members. 

 066787 An incident was resolved for multi-tower models where the replicate-by-story command between 
towers did not always work correctly, and subsequently exporting and then re-importing the 
model using the text file (.E2K, .$ET) could result in an error condition. 

 067034 An incident was resolved where joints and objects when drawn for multi-tower models would be 
assigned to incorrect towers in some cases when the tower was not explicitly specified and the 
“Auto” option was used.  The following process is now used to determine the tower assignment 
when the “Auto” option is used: 
(1.) When using Quick Draw options, the tower assigned is based on the tower associated with the 
grids that are clicked.  If grids overlap, the tower defined first is assigned.  The Similar-Story option 
is then applied only to the stories of this tower. 
(2.) When drawing on-screen without using Quick-Draw tools, the tower associated with the 
current Plan view, Elevation view, or Working Plane in a 3D view is assigned. 
(3.) When drawing in 3D without setting a working plane, the tower associated with the first object 
snapped-to when starting to draw the object is assigned. 
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* Incident Description 

 067292 An incident was resolved where it was possible to have duplicated elements in multi-tower 
models. The duplicated elements were at the same location but belonged to different towers.  This 
is now detected and prevented, and previous models are corrected as needed when opened. 

 067962 An incident was resolved where, in certain multi-tower models, the option to merge towers or 
delete towers did not work correctly.  This could corrupt the model and later cause an error 
condition when working with the model. 

 089694 
093956 
097301 
103835 

An incident was resolved where, when selecting columns in a plan view using the window selection 
for a model with multiple towers, columns would be selected both below and above the story 
level.  Only columns below the story level are supposed to be selected in plan views. 

 093182 An incident was resolved for multi-tower models where the joints created when drawing frame, 
shell, and link objects in one tower would be assigned to the default tower.  This could cause 
connectivity problems when the model was exported to text file (.E2K, .$ET) and then re-imported. 
In addition, this could cause wall objects to be drawn with the incorrect geometry if the story 
levels were different between the tower where drawn and the default tower.  When this occurred, 
the effect was obvious and results agreed with the model as drawn. 

 095065 An incident was resolved where selecting an object in a plan view when multiple towers are being 
modeled would sometimes select more items than actually clicked on. 

 062082 
065813 
093398 
096955 

An incident was resolved where, for multi-tower models, exporting and re-importing the model 
using the text file (.E2K, .$ET) did not always bring in all members.  This caused an error condition 
later when generating joint tables. 

 201537 An incident was resolved for multi-tower models where selecting columns while the “All Stories” 
option was active did not always select all the columns on that same column line. 

 202501 An incident was resolved for multi-tower models where the story limits selected under the 
command View > Set Building View Limits did not always work correctly, causing more or less of 
the building to be displayed than expected.  No results were affected. 

 101747 An incident was resolved where, when importing a DXF file into a multi-tower model, the form 
used to choose the vertical elevation for import did not always display the correct story names. 

 103423 
214217 
233364 

An incident was resolved for multi-tower models where in some cases the data written out to the 
text file (.E2K, .$ET) was not sufficient to re-import the model from the text file.  The binary model 
file (.EDB) was not affected. 

 100272 An incident was resolved where for multi-tower models the “Quick Draw Walls” option and the 
replicate option for walls on another story did not always work correctly. 

Meshing 
Incidents Resolved 

* Incident Description 

 100336 An incident was resolved where the automatic Rectangular mesh option for floors did not recognize 
the end points of wall objects from the story above, and hence the floor mesh did not always 
connect fully to the wall.  This issue did not affect the floor above the wall, and hence also did not 
affect the floor below if the wall was continuous between stories.  Results agreed with the model as 
meshed.  Now the end points of the wall will be explicitly included in the rectangular mesh of the 
floor below.  Intermediate wall points will connect to the floor below using edge constraints, as they 
did before.  This issue did not affect the automatic General mesh option for floors, which fully 
meshes to walls above and below the floor. 

 200892 An incident was resolved where the meshing of shells was not correct at visible grids for a particular 
model.  The issue was due to a tolerance problem when determining the intersection of two nearly 
parallel lines.  The behavior has been improved. 
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* Incident Description 

 220061 
220966 

An incident was resolved where, in certain cases, the general meshing would not work correctly near 
openings.  When this occurred, the error was obvious, and manually adding some meshing lines to 
connect the opening to the nearest column or wall support would resolve the problem. 

 221514 An incident was resolved where an error condition occurred during the creation of the analysis 
model if a wall was assigned a hinge after the model had been run earlier with the wall being 
assigned any type of meshing, which then stored an internal mesh for future runs.  Meshing of wall 
objects with hinge assignments is not allowed.  This is now being detected and the stored mesh is 
deleted after a hinge is assigned. 

 221714 
221833 

An incident was resolved where general meshing on an inclined floor was, in some cases, creating a 
mismatched mesh that could cause the analysis to experience convergence problems for nonlinear 
load cases.  The general meshing feature has been improved to create better connected meshes. 
Models from previous versions will have their automatic floor meshes deleted when opened in the 
new version so that an improved mesh will be regenerated next time the analysis is run. 

 221130 
222082 
222221 
222750 

An incident was resolved where the intersection of nearly parallel lines and/or edges was causing 
errors in the mesh created by the general mesher.  This happened when lines/edges that were 
supposed to be in the same location were slightly off.  Tolerances have been modified and new 
checks added to minimize this problem. 

 228681 An incident was resolved where, during meshing of a floor, a drop panel near to a wall was 
sometimes meshed as an opening. This was a rare case and the error was obvious when it occurred. 

 228333 An incident was resolved where the General mesher would not pick the nodes of a brace member as 

joints to be included for floor meshing unless the joints were themselves tagged as mesh points. Now 

they are treated the same as the nodes for a column and automatically included. 

* 227177 An incident was resolved where general meshing of certain floor objects, such as very acute 
triangles, could create illegally shaped elements that prevented the analysis from running.  The 
general meshing feature has been improved to create valid meshes in such cases.  Models from 
previous versions will have their automatic floor meshes deleted when opened in the new version so 
that an improved mesh will be regenerated the next time the analysis is run. 

 232231 An incident was resolved where the saved floor mesh was not being updated for analysis if the floor-
meshing type or mesh size was not changed, but other options were changed, such as where to 
mesh (at grids, etc.). Now the saved mesh will be regenerated at analysis time if any meshing option 
is changed that applies to the floor object. 

 232435 An incident was resolved where joint offsets were sometimes not properly interpolated to shell 
elements when a shell object (e.g., wall or floor) was meshed. This error only affected the following 
case where three conditions were met: (1.) the shell object had more than four joints, and some of 
the joints were co-linear or nearly so along a skewed line; (2.) the shell objects had explicit joint 
offsets defined beyond the implicit offsets that are created for the top-of-slab cardinal point; and 
(3.) the object was assigned that the stiffness was to be transformed for the effect of joint offsets or 
a tendon was present in the model.  When this error occurred, some joints of the shell elements 
generated by meshing the shell object might not have been properly offset, resulting in elements 
that were inclined.  If the resulting element was excessively distorted the analysis produced an error 
message in the .LOG file and the analysis was stopped.  Otherwise, results for the affected elements 
may have been inaccurate. 

Analysis 
Incidents Resolved 

* Incident Description 

 220150 An incident was resolved where the analysis would become unresponsive if the model file name or 
folder had characters that were inconsistent with the system locale settings.  When this occurred, no 
results were available.  Now the software will give an error message in this case, so that the user can 
change the system locale settings to be consistent with file and folder names. 
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* Incident Description 

 221098 An incident was resolved where the stiffness transformation when the frame object connectivity 
was not specified at its centroid could be slightly off.  This happened for unsymmetrical sections 
when the “transform stiffness” flag was “On”.  The stiffness transformation was off by the distance 
between the centroid and the geometric center of the section bounding box. 

* 222053 An incident was resolved where mass-proportional damping specified in the material property 
definitions was not being considered for shell elements in nonlinear direct-integration time-history 
load cases.  Additionally, this issue sometimes required extra iteration to reach convergence.  Mass-
proportional damping specified in the load case itself was not affected.  Models without shell 
elements or without mass-proportional damping in materials used by shell elements were not 
affected. 

 221172 An incident was resolved where nonlinear analysis of models containing triple-pendulum isolators 
could fail to converge if the isolators went into axial tension.  This occurred because the locations of 
the internal components of the device become undefined when there is no compression to keep the 
multiple surfaces in contact.  Now a small, fictional internal transverse stiffness is assumed to 
provide definiteness in the presence of tension so that convergence can be more readily achieved.  
However, analysis results can still be numerically sensitive when the isolators go into tension, 
depending upon the stiffness characteristics of the isolators themselves and the rest of the 
structure.  Engineering judgment is required to determine if tension is acceptable for these devices. 

 228871 An incident was resolved where a column fiber hinge that contained a fiber assigned using a 
concrete “Mander” curve would, in some cases, create a stress-strain curve that was missing the 
compression side.  When this occurred, an error was generated that prevented the analysis from 
running, and no results were available. 

* 230613 An incident was resolved where the creep and shrinkage strains for frame objects calculated during 
time-dependent staged construction load cases could be incorrect when all of the following 
conditions were met: 
1. The frame objects were assigned a non-zero value of rebar ratio for creep and shrinkage (menu 
command Assign > Frame > Rebar Ratio for Creep Analysis).  
2. More than one time-dependent concrete material property was used in the frame section 
properties for the model. 
3. The analysis was run in a multi-threaded environment. This would normally be the case on any 
machine with more than 2 cores, unless the environment variable SAPFIRE_NUM_THREADS was set 
to 1 (unity).  
Correct results were able to be obtained by setting the environment variable 
SAPFIRE_NUM_THREADS = 1 in Windows Control Panel before starting ETABS. 

Frame Design 
Incidents Resolved 

* Incident Description 

 087610 An incident was resolved for concrete frame column design where Beam/Column capacity ratios 
were incorrectly reported in the detailed design report. The reported capacities were correct and 
only the reported ratios were switched between those obtained from clockwise moments and 
counter-clockwise moments. This was a reporting issue only, and all concrete frame design with 
seismic provisions were affected. 

 100265 An incident has been resolved for steel frame design per the "Chinese 2010" code in which brace 
members were sometimes incorrectly identified with the message "Section is seismically slender." 
This message was over-conservative. No other results were affected. 
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* Incident Description 

 101901 An incident was resolved for concrete frame design using the Chinese 2010 code in which the 
calculation of λ (lambda) for columns was not correct for two reasons: (1.) In the calculation of λ, the 
full depth of column was used instead of the effective depth h0. λ should be equal to M/(V*h0). (2.) 
The program used the values of M and V after modification with magnification factors SMF and 
MMFs instead of using the values of M and V before modification with magnification factors SMF 
and MMFs. The calculated λ values should not change with the overwrites of magnification factors 
for columns. This issue was only present for columns. The lambda values for beams are calculated 
based on the actual presence of a point load, if any. If there is no point load on the beam, then λ is 
taken as 1.5. The calculation of λ for beams was not changed. Note that this incident was 
erroneously reported as being resolved in the Release Notes for ETABS v17.0.0, which was not the 
case. 

 101908 An incident was resolved for concrete frame design per the Chinese 2010 code in which the 
calculation of the minimum rebar for columns was not correct. This affected only the concrete 
column design. This did not affect column checking or beam design. 

 215273 
215524 

An incident was resolved for concrete frame design where the moments for negative bending were 
sometimes reported as zeroes in the table “Concrete Beam Flexure Envelope”, based on whether 
the tension-side required rebar (top) for negative moment was less than the compression-side 
required rebar (top) for positive moment, and vice-versa. This was a reporting issue only. The design 
procedure and all other results were not affected. The design procedure considers all the steps 
within a multi-step load case or multi-valued load combination, so that the net enveloping rebar 
requirements were reported correctly. 

 217361 An incident has been resolved for steel frame design per the Indian "IS 800:2007" code where the 
design preference form showed zones as 0 to 4 but these should instead be from Zone II to Zone V. 
Previous zones 1 to 4 correspond, respectively, to zones II, III, IV and V, and previous zone 0 is now 
treated as zone II. After considering the updated numbering, results were otherwise not affected. 

 219905 
220967 
221298 
240226 

An incident was resolved where concrete frame design would produce an error condition when 
there was an inconsistency between the analysis section of a member and its design section in the 
specific case where one was of type prismatic and the other was of type non-prismatic. When this 
occurred, design results were not available for that member. Analysis results were not affected and 
were consistent with the analysis section. 

 221686 An incident was resolved for steel frame design using codes “Eurocode 3-2005”, “Italian NTC 2008”, 
and “Indian IS 800:2007” in which the PMM interaction ratio for the section-capacity check of 
rectangular hollow sections became extremely large when the axial force ratio n, (n=Ned/Npl,Rd), 
became slightly larger than 0.9407 (n>1/sqrt(1.13) but still less than 1.0.  In this case the 
denominator of the expressions for Alpha and Beta became a very small negative number, causing 
Alpha and Beta to be very large negative numbers.  These, in turn, produced extremely large values 
for [My,Ed/Mn,y.Ed] and [Mz,Ed/Mn,z.Ed].  Now, n is limited to 0.7375 when calculating Alpha and 
Beta so that they do not exceed the code-specified limit of 6.0 or become negative.  This issue was 
sometimes causing problems when creating certain database tables because of the large numbers. 

 222713 
223862 
227924 

An incident was resolved for concrete frame design per the ACI 318-14, ACI 318-11 and ACI 318-08 
codes where no warning was reported when the delta_ns factor was greater than 1.4. Now this is 
checked and a warning message is provided in the design report and design tables when the 
delta_ns factor exceeds the 1.4 limit. 
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 228113 An incident was resolved for steel frame design per the Russian code SP 16.13330.2011 affecting 
some of the interaction equations used to determine the D/C ratio of pipe sections: 
(1.) The interaction equations of section p9.2.2 were calculating the parameter phi_e based on the 
major- and minor-axis bending moments separately. Now the parameter phi_e is based on m_ef for 
the resultant bending moment M = Sqrt(M22 + M32). The previous results were under-conservative 
regarding this. 
(2.) Equations 120 and 121 of section p9.2.10 were being used to determine the D/C ratio of pipe 
sections. This was not necessary, and this interaction equation is no longer used. The previous 
results were slightly over-conservative regarding this. 

 228119 An incident was resolved for concrete frame design per the Russian code SP 63.13330.2012 in which 
the limiting strain epsilon_b2 was not being reported correctly. The short-term limit concrete strain 
was determined using p.6.1.20 SP63 and was correct for both concrete beams and columns. This 
was a reporting issue only. Design results were not affected. 

* 234629 An incident was resolved for steel frame design per the “Eurocode 3-2005” code where the demand-
capacity ratio (D/C) computed for closed pipe and tube (box) sections could be unconservative in the 
presence of significant torsion.  For the design of pipe sections, the shear stress (tau) due to torsion 
was being calculated using c = t/2 instead of c = d/2 in the formula tau = T*c/J.  A similar error 
occurred for tube sections, where the computed stress was proportional to the wall thickness rather 
than to the exterior dimensions of the section.  This error affected the calculations of the strength 
reduction factor, reduced shear capacity for the presence of torsion, and reduced flexural capacity 
for the presence of torsion.  The resulting D/C ratios were smaller than their correct values in the 
presence of torsion.  Only pipe and tube sections were affected.  In the absence of torsion, the D/C 
ratios were correct. 

 225637 An incident was resolved for concrete frame design code “Chinese 2010” in which the Beam Gravity 
Neg Moment Reduction Factor parameter set in the design preferences was not being used. 
Members used a default value of 1.0 unless a design overwrite assigned a different value. Now the 
default value of the Beam Gravity Neg Moment Reduction Factor for members without overwrites 
will be taken from the design preferences. The default value in the design preferences has been 
changed from 1.0 to 0.85, but this can be changed by the user. 

 225688 An enhancement was made to update the design details output for concrete frame design code 
“Chinese 2010”.  Previously the values for N, M2, and M3 were reported only after all modifications. 
Now the design reports those forces that directly come from the load combinations, and all 
manipulated values are reported later in the design output.  No results are affected. 

 239399 An incident was resolved for steel frame design per the Russian code “SP 16.13330.2011” which 
corrected the following issues: 
(1.) The sign of axial force N is now taken as negative for compression for the calculation of delta in 
equation (108) of section 9.1.3 and in equation (122) of section 9.2.10. Previously the factor delta 
was always 1.0 (unity) for compression. Now it is always greater than 1.0 for compression. The factor 
delta was and still is taken as 1.0 for positive N. This factor is not used when the member is in 
tension. The previous results were over-conservative. 
(2.) The equation eta = (0.75 + 0.05*m) – 0.01*(5.0 - m)*lambda_bar is now changed to equation eta 
= (0.75 + 0.05*m) + 0.01*(5.0 - m)*lambda_bar by changing the subtraction to addition for minor 
axis bending of I-shapes (Section type 8) per Annex E, Table E.2, Section type 8 for Af/Aw = 0.25. The 
net effect is that eta for this case will have an increased value, the factor m_ef will have an increased 
value per equation (110) of section 9.2.2, the stability factor phi_e will have a reduced value per 
Table E.3, 9.2.2, and the PMM ratio will have a slightly increased value. Previously the design was 
slightly unconservative. However, the overall effect was usually small since the minor-axis bending 
moment for I-shaped members is normally small; for larger moments in minor direction, the effect 
was null since the affected equation does not apply in that case. 
(3.) For the stability check of axial compression with flexure for box (tube) and pipe sections, only 
Section 9.2.10 Equations (120) and (121) are now being checked. The following interaction equations 
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are no longer checked for this case: Section 9.2.4 Eqn. (111), Section 8.2.8 Eqn. (59) and (60), Section 
9.1.1 Eqn. (106), and Section 9.1.3 Eqn. (107a). The previous results were over-conservative. 
(4.) When the Eqn. (107) of section 9.1.3 governed, the reporting of this equation and the ratios was 
not correct. In some cases, M_y was being reported instead of M_x. In addition, for singly-symmetric 
I-sections, Double-Angles, and T-sections, the minor axis bending is now ignored. For Double-Angles 
and T-sections, this interaction equation is now only checked if the major moment is positive. In this 
case, the maximum tension occurs at the bottom tip. For Channel sections, both the minor and 
major moments are considered as both affect the tensile stress at the tips. 
(5.) For some T-sections, there was a discrepancy between the reported Lambda_bar from its hand 
calculated value even though the Lambda (KL/i) matches exactly. This was caused by inconsistency 
of radius of gyration and Sqrt(I/A) where all of these three quantities (I, A, and i) are taken from the 
section-property database file. Now the radius of gyration i from the section database is used to 
calculate KL/i rather than using Sqrt(I/A). 

 240117 An incident was resolved for steel frame design per the AISC 360-16 code where the compression-
flange local buckling capacity was underestimated for I, channel, and double-channel sections with a 
slender web and non-compact flanges. 

Composite Beam Design 
Incidents Resolved 

* Incident Description 

 061846 An incident was resolved for composite beam design that affected beams skewed in plan.  When a 
beam supported on its right side with other beams framing into it at an angle other than 90 
degrees, the effective width automatically computed for the right side of the beam supporting the 
others was zero.  When this occurred, the designs produced were slightly conservative, and the 
effective width on the right side of the beam was reported as being zero in the beam composite 
design output.  The user had the option of specifying a positive effective width in the beam 
composite design overwrites, which avoided this problem. 

 215321 An incident that affected composite beam design per Eurocode 4-2004 was resolved.  Previously, 
when a class 3 section was chosen for the design of a composite beam and that section did not 
have an adequate elastic positive-bending capacity, the member was reported as having failed, but 
the reported bending-capacity check was incorrectly based on plastic bending capacity and 
appeared to be adequate.  However, this issue is now moot due to the further enhancements to 
composite beam design per Eurocode 4-2004 as described for Incident 221321 in these Release 
Notes:  ETABS now implements EC4 Clause 5.5.2(3) and computes the design resistance moment 
of sections that have webs in class 3 and flanges in class 1 or 2 as effective cross-sections in class 2, 
with their effective web areas reduced per EC3-1 Clause 6.2.2.4. 

 217222 An incident has been resolved for composite beam design which affected the reports generated 
for the case when the deck adjacent to the beams was of type solid slab as opposed to filled or 
unfilled deck.  For solid slabs, the deck width and the concrete moduli of elasticity used to check 
strength and deflection were mislabeled, the concrete modulus of elasticity used to check 
vibrations was not reported, and the shear stud strength was not reported.  This was a reporting 
error only for the input values.  The design results themselves were correct.  This affected all 
composite beam design codes in all versions of ETABS from v13.2.1 to v17.0.1. 

 217420 An incident was resolved that addressed several issues with composite beam design related to 
web openings:  
(1.) When designing a composite beam in interactive mode, if the user specified opening 
reinforcing plates that did not satisfy the AISC compact-section requirements in the Beam Web 
Penetration form and then clicked OK, the user could not return again to the Beam Web 
Penetration form.  The only way then to modify the openings for the beam was to export the 
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model to an .e2k text file, change the dimensions of the plates in a text editor, and re-import the 
model from the .e2k file.  
(2.) In the Interactive Composite Beam Design form, the ratios displayed next to each design in the 
list of alternate designs were the largest of the ratios computed for the beam overall strength, 
stiffness, and vibration checks, and did not take into account the interaction ratios at the various 
web openings along the beam.  However, the web opening ratios were correctly updated and 
displayed in the Strength Checks section of the form when the user selected a particular design.  
(3.) When viewing composite beam design results, the beam colors depicted the largest of the 
ratios computed for each beam overall strength, stiffness, and vibration checks, but did not depict 
the interaction ratios at any of the beam web openings.  
(4.) When the shear studs placed on a beam to satisfy maximum stud-spacing requirements 
provided more than 25% composite action, but no composite action was needed to satisfy the 
overall beam strength and stiffness design requirements, any web openings on the beam were 
checked as if the beam was non-composite.  This could lead ETABS to incorrectly reject some 
viable beam designs.  Setting the beam type as Force Composite in the Shear Studs tab of the 
Beam Overwrites solved the issue.  
(5.)  When a beam was designed as non-composite but had shear studs on it anyway, any web 
openings were checked to assume no composite action, except that the value of the phi factor was 
0.85 instead of 0.9.  This was slightly conservative. 

 219576 An incident was resolved that affected composite beam design per the CSA Canadian design codes. 
When checking the negative bending capacity of a composite beam per the CSA Canadian design 
code with a section classification other than Class 1, (Class 2, Class 3 or Class 4), ETABS did not take 
into account the unbraced length of the beam.  When this occurred, the error was obvious in the 
interactive design form and in the output as the corrective negative bending capacity of the beam 
was displayed on the form and reported in the output.  All versions of ETABS that design 
composite beams per the Canadian Code, versions 9.7.0 to 17.0.1, were affected. 

 220034 
220885 
220988 
221955 

An incident was resolved that affected composite beam design per the AISC 360-05 and AISC 360-
10 codes in ETABS v17.0.1.  The compactness of the webs of trial design sections was incorrectly 
checked and was essentially always classified as compact when the database length unit was feet, 
inches, meters or centimeters, and was always classified as non-compact when the database 
length unit was millimeters.  Only ETABS 17.0.1 was affected by this incident.  Note that per AISC, 
all AISC rolled ASTM A6 W, S, and HP shape sections have compact webs at Fy ≤ 65 ksi, and that 
when the database length unit was millimeters, no designs were generated.  The compactness of 
the webs of trial section was otherwise properly checked when the design code was AISC 360-16. 

* 223907 An incident has been resolved that addresses two issues for composite beam design per the 
Eurocode 4 code:  
(1.)  When checking the construction bending capacity or the negative bending capacity of a 
composite beam per Eurocode 4, ETABS did not take into account the unbraced length of the 
beam.  
(2.)  The design resistance moment of composite beams was not being reduced per Eurocode 4 
Clause 6.2.2.4 when the shear-design forces exceeded 50% of the beam shear-design resistance.  
All versions of ETABS that design composite beams per Eurocode 4 (v13.0.0 to v17.0.1) were 
affected by these two issues. 



ETABS v18.0.0 ISO# RELETA1800     2019-06-12 Page 22 of 29 

* Incident Description 

 216713 An incident was resolved for composite beam design that affected beams adjacent to floor objects 
having Slab section properties.  When designing such beams, the design incorrectly assumed 
composite action with the slab and used incorrect concrete strength and slab thickness. The 
strength used was that of the first concrete material defined in the model, and the deck was 
assumed to have ribs of depth 3 in. or 75 mm, and a concrete cover of thickness 3.5 in. or 87.5 
mm.  Composite beams adjacent to floor objects with slab properties are now designed as non-
composite, as stated in the manual.  Floor objects that are intended to provide composite action 
should be defined as deck sections, which include an option to model solid slabs.  This error 
affected ETABS Versions 13.0.0 to v17.0.1.  Note that this incident did not affect the more common 
cases of beams adjacent to floor area objects with Deck section properties, even when these Deck 
section properties were of type “Solid Slab”. 

 233179 An incident was resolved which affected composite beam design per Eurocode 4-2004 when the 
Option “Use Multi-processing for Design/Results” was turned on and the model database length 
unit was not millimeters:  
(1.) Some of the beam sections were randomly and incorrectly classified as non-compact, resulting 
in excessive stress ratios being reported.  
(2.) The shear-stud capacity was randomly under-evaluated for some beams, resulting in these 
beams being deemed inadequate due to shear-stud crowding.  
These errors were obvious when they occurred, and they were conservative.  These errors did not 
occur when designing beams interactively, or when the Option “Use Multi-processing for 
Design/Results” was turned off.  Only versions 17.0.0 and 17.0.1 had this option and could be 
affected.  Models initially created or imported in metric units were not affected, while models 
initiated in U.S. Customary units were affected. 

Shear-Wall Design 
Incidents Resolved 

* Incident Description 

 220080 An incident was resolved where opening a model in ETABS v17 that was created in an earlier 
version would reset the option from “check” shear wall with uniform reinforcing to “design” shear 
wall with uniform reinforcing.  Resetting the option to the desired value in v17 would correctly 
retain the value.  This affected versions v17.0.0 to v17.0.1. 

* 218753 
220962 
222586 
222864 

An incident was resolved for shear wall design based on the General Pier Section (i.e., a Section 
Designer section) where design was unable to calculate the interaction diagram when the section 
designer section included a rectangular rebar layout for the edge zone.  The issue only affected 
ETABS v17. No other results were affected. 

* 213978 
226014 
226527 

An incident was resolved for shear wall design of piers based on the Eurocode where right-clicking 
on a wall pier to obtain details would give results inconsistent with what is shown on the model 
display.  This was related to an initialization issue and affected piers where additional moments 
due to slenderness were required to be added for design. 

Slab Design 
Incidents Resolved 

* Incident Description 

 207438 An incident was resolved for slab design per the ACI 318-14 code where one-way shear design was 
enforcing the minimum value Avmin when Vu > 0.5*phi*Vc instead of using the correct condition 
Vu > Phi*Vc. 

 209917 An incident was resolved for slab punching check where a column with insertion point offsets was 
causing the program to give an error message and not calculate punching shear at that column. 
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 220220 An incident was resolved where the units shown when displaying Punching-Shear reinforcement 
results would not change when the display units were changed. 

Results Display and Output 
Incidents Resolved 

* Incident Description 

 215396 An incident was resolved where an abnormal termination could occur when attempting to 
generate a report containing auto seismic load patterns that did not have a load direction selected. 
Results were not affected. 

 217235 An incident was resolved where the display of response values (displacements, forces, stresses) on 
the model at the location of the mouse cursor sometimes became inactive after zooming in when 
using DirectX graphics mode.  Rotating the model would restore the correct display behavior until 
the next zoom operation.  No results were affected. 

* 214931 An incident was resolved where the overturning moment shown in the story response plots was 
incorrect when the model had no joints present at the Base story level, which is not common.  
Only the story response plots were affected.  The overturning moment shown in the table for story 
shears was correct.  No other results were affected. 

 215146 
215228 

An incident was resolved where Max/Min strip forces presented in the tables was only showing 
the Max forces as both Max and Min. Slab design was not affected by this issue.  In addition, the 
strip-forces diagram has been enhanced to show both Max and Min forces on the same diagram 
similar to the way frame forces are displayed. 

* 224294 
225204 

An incident was resolved where the user-generated report would not populate the calculation 
results for concrete frame and shear wall designs even though the option to generate these 
calculations was activated under the report options.  This issue only affected versions v17.0.0 and 
17.0.1. 

 225106 An incident was resolved where an abnormal termination occurred when plotting hinge results for 
a staged-construction load case defined to produce output at the “End of Each Stage”.  No results 
were affected.  This did not occur for other output options on the load case, such as “Start and End 
of Each Stage”. 

 227944 An incident was resolved where the contour range calculated for display of slab moment/stresses 
was very high due to the presence of stiff areas over columns and walls.  Forces/stresses for stiff 
areas are now excluded for calculating the range giving better contour definition over the flexible 
portions of the slab.  This was a display issue only and no design results were affected.  The design 
already excludes stiff areas over columns and walls. 

 220812 An incident was resolved where the joint reaction information displayed by hovering the mouse 
cursor at a joint did not correspond to the reaction at that joint.  This was a rare occurrence and 
happened only in developed elevations and only at internally created meshing joints. 

 228650 
228738 

An incident was resolved where tables of analysis results, such as Base Reactions and Story Forces, 
could produce incorrect values for some load cases or load combinations if, and only if, results 
were also requested for a load combination that was invalid, i.e., it was defined to contain no load 
cases or load combinations.  This was not common.  Now such load combinations will be excluded 
from the results tables, even if requested.  Likewise, load combinations for which no results are 
available (i.e., one of the contained load cases had not been run) will also be excluded from the 
tables.  This was just a reporting issue and no analysis or design results were affected. 

 225636 An incident was resolved where the formulas given in the report for the calculations of seismic 
loads for the Chinese code were not updated to the latest version.  The program calculated loads 
were based on the updated formulas. This was a reporting error only and no results were affected. 
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 225945 An incident was resolved where an error could occur when attempting to create a report based on 
an XML contents file that included an entry for a table with a filter or sort specified.  Results were 
not affected.  In particular, this could affect the built-in Chinese Summary Report, which uses 
filtering. 

Graphics 
Incidents Resolved 

* Incident Description 

 082215 An incident was resolved where deselecting the option Options > Graphics Preferences > Constant 
Line Thickness caused the grid bubbles to not display correctly in elevation views.  This was a 
display issue only. 

 088676 
100326 

An incident was resolved where a request to show the analysis mesh would result in the analysis 
mesh being shown with black lines that could not be seen on a black background.  This was a rare 
occurrence and would happen only after returning to an undeformed shape after previously 
displaying a deformed shape with contours. 

 222028 An incident was resolved where trying to animate a deformed shape for a load combination would 
sometimes cause an error condition.  This only affected version 17.0.1 and only if the load 
combination being displayed had an index larger than the number of load cases.  No results were 
affected. 

 222080 An incident was resolved that corrected several minor issues related to DirectX graphics.  No 
results were affected.  Specific items include: 
(1.) Fine-Grid snapping did not work as expected. 
(2.) Perpendicular snapping did not work as expected. 
(3.) Sometimes the Reshape Object Tool would not work as expected. 
(4.) Floor midpoints could not be selected when using the Reshape Object tool. 
(5.) Member end-moment releases were shown as “x”, which was similar to joint objects.  Now 
they are shown as circles, like they are when using standard graphics. 
(6.) Section assignments for membrane, deck, and plank floor objects were always being shown, 
even though they were turned off for the view using the Set Display Options command. 
(7.) Fixed supports were not shown similar to the way they are when using standard graphics. 
(8.) Walls were not included in the view when showing the shell analysis mesh. 
(9.) The contour color range was not displayed in plan views. 
(10.) Slab design results by FEM were not visible in either plan or 3D views. 
(11.) The animation for deformed shape became distorted when contours were shown. 

 225128 
227002 

An incident was resolved where, for certain model files, the shell mesh with a floor opening would 
not display correctly in DirectX graphics.  This was only a display issue and no results were 
affected. 

 231062 An incident was resolved where a wall in plan view would not show correctly if only one node of 
the wall was at the plan level.  No other views were affected and no results were affected. 

 237125 An incident was resolved where shells with curved edges or with openings may not display 
correctly in a plan view when filled (command View > Set Display Options > Object Fill). 

User Interface 
Incidents Resolved 

* Incident Description 

 086562 An incident was resolved where the menu command File > Create Video > Multi-step Animation 
was available when it was not applicable, causing an error condition when clicked on.  No results 
were affected. 
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 215471 An incident was resolved where the software sometimes terminated abnormally when selecting by 
groups.  This would occur if the selection operation was performed after performing the following 
sequence of operations: (1) An operation that automatically added a group, such as drawing auto 
cladding, then (2) undoing that operation, and finally (3) repeating the same or a similar operation. 
When this occurred, changes to the model since the last Save could be lost. 

 219927 An incident was resolved where the text boxes for showing bar spacing would sometimes be 
greyed out and non-editable when displaying finite-element slab-design information. 

 220631 An incident was resolved where the units for the “Precompression Displacement” and “Stop 
Displacement” values at rotational degrees of freedom in a link property of type “Damper – 
Friction Spring” were shown on the property definition form as degrees rather than radians.  This 
was a typographical error only.  The values specified were being treated as radians, consistent with 
all rotational displacements.  The text on the form has been corrected.  Results will not change 
from previous versions. 

 220826 An incident was resolved where linear and nonlinear modal time history load case definitions with 
the initial conditions set as “Zero Initial Conditions – Start from Unstressed State” always showed 
the default mass source, which was incorrect if the selected modal load case was defined to use a 
mass source other than the default.  This was a user interface issue only and did not affect results. 
The mass source actually used was shown in the analysis log (.LOG) file. 

 209674 An incident was resolved where nonlinear material property stress-strain data for masonry 
materials that was set to be user-defined was always set back to the default parametric definition 
after clicking OK on the Nonlinear Material Data form (menu command Define > Material).  Results 
were consistent with the parametric stress-strain curve, not the user-defined curve.  Only 
masonry-type materials were affected. 

 215526 An incident was resolved where a frame section was not displayed correctly in the Frame Section 
Property Data form (where section dimensions are specified) when any of the dimensions were 
small compared to the Auto Merge Tolerance specified for the model.  A tighter tolerance is now 
used for showing the section.  This was a display issue only.  No results were affected. 

 225866 An incident was resolved where deleting a diaphragm after user-type Wind Loads had been 
assigned to it would cause an error condition when the file was saved. 

 227777 An incident was resolved where in some rare cases changing the interaction type of an interacting 
frame hinge property (P-M2, P-M3, P-M2-M3) and then assigning it to a frame would result in an 
error message and no assignment would be made.  Other hinge property types were not affected. 

 240482 An incident was resolved that corrected minor functional issues with the forms in the graphical 
user interface used to input data. No results were affected. 

 229778 An incident was resolved where the labels for the “Symmetry Condition” options on the Frame 
Hinge Property Data form used to define interacting P-M2-M3 hinge properties changed and 
became incorrect when the “Hinge Specification Type” was changed from “Moment - Rotation” to 
“Moment - Curvature”, and vice-versa.  This was a labeling issue only.  The selected options 
themselves were not affected.  This form is obtained using the menu command Define > Section 
Properties > Frame/Wall Nonlinear Hinges. 

 229917 
233605 

An incident was resolved where an abnormal termination could occur when only wall objects were 
selected and the Merge Shell option was used.  The Merge Shell operation only applies to floor 
(horizontal) objects.  Any selected wall objects will now be ignored, but no error will be generated. 

 232481 An incident was resolved where property modifiers defined in shell (slab, deck, wall) section 
properties retained the values entered on the data form even if the Cancel button was clicked.  
The values used in the model could be seen by going back into the form or by checking the 
database tables.  Results agreed with the property modifiers as shown. 
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* 238797 
238812 
238816 
238847 
238887 
238910 
238948 
238961 
238993 

An incident was resolved in which the program could terminate when starting up and checking for 
the latest version.  This was related to interaction with a web endpoint that was being blocked by 
OpenDNS, an outside vendor. 

 240629 An incident was resolved where the software could terminate abnormally when trying to modify 
the rebar for a layered shell property. This could occur when the "Size and Spacing are the Same 
for All Rebar" option was selected and the number of rebar layers was 1. 

Database Tables 
Incidents Resolved 

* Incident Description 

 206640 An incident was resolved where the export of analysis results to Access format failed for a 
particular model containing multiple towers. 

* 220183 
221529 
221555 
222128 
226255 

An incident was resolved where the database table “Assembled Joint Masses” was incorrectly 
reporting the masses for three of the joints in the table.  For these joints, the total mass of the 
structure was being reported, with each joint reporting the total mass in a different direction.  The 
affected joints could be in any order in the table, and were easily identifiable as the joints having 
the largest masses in the table.  For the most part, this was a reporting error affecting this table 
only.  However, the incorrect mass values were also being used to compute the seismic mass that 
is then used to determine the performance point when plotting static pushover curves.  The net 
effect was to nearly double the seismic mass.  Only the performance point was incorrect.  No other 
results were affected. 

 216801 
222212 

An incident was resolved where an error message was generated when trying to display or export 
the table for concrete material properties whenever time-dependent properties (creep, shrinkage, 
stiffness) had been defined using the AS3600-2009 code.  No results were affected. 

 209797 An incident was resolved where, in certain cases, requesting a table of results for a load 
combination of type algebraic that contained other load combinations within its definition would 
result in an error condition.  When this occurred, the requested results were not available. 

 214136 
232766 

An incident was resolved where the weight of the non-prismatic frames reported in the material 
list table may be incorrect when the non-prismatic section included absolute-length segments.  
The reported weight was correct if the non-prismatic section included only variable-length 
segments.  This was an issue with the weights shown in the material list tables only and did not 
affect the weights used in analysis or design. 

 223523 
224975 

An incident was resolved where exporting a Table Set to Excel did not properly convert for units 
when multiple tables were present in the Table Set.  This error did not occur for individual tables. 
In the new version, Tables Sets have been replaced with Named Table Sets, and the unit-
conversion issue has been resolved.  Units for export to Access, Text, and XML are consistent and 
requested at the time of export.  Units for Excel may be consistent or inconsistent and are based 
on Display Units currently set for the model. 
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Data Files 
Incidents Resolved 

* Incident Description 

 219755 
219949 
222075 

An incident was resolved where opening a file saved in ETABS versions 17.0.0 or 17.0.1 would 
generate an error message “Exception Type: Unknown version encountered” for some models. 
This error was limited to files where composite column design overwrites were present. 

 220205 An incident was resolved where an unsymmetrical steel shape used with a “Mirror about...” option 
selected in a Section Designer section would not keep that option once exported and imported 
through the model text file (.e2k or .$et). 

 233859 An incident was resolved where the shear area for pipe sections imported from .XML files was 
incorrect for the following section libraries:  AISC13, AISC13M, AISC14, AISC14M, AISC15, AISC15M, 
AISCLRFD2, APSCLRFD3, ASTM A1085, AusNZ8, CISC9, CISC10, Euro, Nordic.  Analysis results were 
based on the shear areas shown in the frame section definitions. 

 239470 An incident was resolved where the import of Section Designer sections from text files (.E2K, .$ET) 
was not working properly. This only affected creation of fibers for fiber hinges. No other results 
were affected. 

External Import/Export 
Incidents Resolved 

* Incident Description 

 090432 An incident was resolved where importing a DXF file as an architectural layer into a multi-tower 
model could generate error messages during the import process, and further error messages could 
be generated when later changing views to 3D or moving up and down story levels in a plan view.  
No results were affected. 

 217920 An incident was resolved which affected the export from ETABS to Revit of line objects that had 
joint offsets specified in the line-object local coordinate system.  These line objects were exported 
to Revit as if the coordinates of the joint offset had been specified in the global coordinate system.  
When this occurred, the discrepancy with the ETABS model was visually obvious in the Revit 
project.  This occurred with all versions of ETABS capable of exporting models to Revit.  Line 
objects whose joint offsets were specified in the global coordinate system were correctly 
exported. 

 220038 
221427 
222526 
223074 
224851 

An incident was resolved where response-spectrum load cases exported from ETABS v17 to SAFE 
reported zero base shear in SAFE because the scale factors for modal mass and modal stiffness 
were not being exported from ETABS v17.  Only versions v17.0.0 and v17.0.1 of ETABS were 
affected. 

Application Programming Interface (API) 
Incidents Resolved 

* Incident Description 

 204541 An incident was resolved for the Application Programming Interface (API) where the functions 
cFrameObj.SetLoadPoint, cFrameObj.SetLoadDistributed and cFrameObj.SetLoadTemperature 
always added load rather than replacing the existing load regardless of whether the Replace 
argument was set to True or False. 

 208487 
233700 

An incident was resolved for the Application Programming Interface (API) where the function 
cAnalysisResults.AreaStressShell was only extracting a number of results for each load case or load 
combination requested equal to the number of points in the selected area elements even though 
more results were available (such as for Max/Min or stepped results). 
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* Incident Description 

 216502 
221460 

An incident was resolved for the Application Programming Interface (API) where the wrong unique 
name could be returned for certain objects in the following cases:  (1.) Function 
cAreaObj.GetNameFromLabel could return the wrong unique name when the model contained 
multiple types of area objects (floors, walls, null areas).  (2.) Function 
cAreaObj.GetNameFromLabel could return “null” for the name of wall objects if the model 
contained only wall and null-area objects (no floors or slabs).  (3.) Function 
cFrameObj.GetNameFromLabel could return the wrong unique name when the model contained 
multiple types of frame objects (beams, columns, braces). 

 219227 An incident was resolved for the Application Programming Interface (API) where the functions 
LoadCases.*.GetInitialCase would return “None” for linear, nonlinear static, staged construction, 
or direct-integration time-history load cases that continued from a nonlinear staged construction 
load case. Also the function LoadCases.StaticNonlinearStaged.GetStageData_2 was unable to 
return the correct ObjectType and ObjectName values when the Object Type defined in the stage 
operation was “Story”. 

 219803 An incident was resolved in which the API functions cCombo.GetCaseList, 
cPropFrame.GetAllFrameProperties, cPropFrame.GetPropFileNameList, and 
cConstraint.GetDiaphragm would generate an error when the API script referenced ETABS2016.dll 
and was used with the ETABS v17 program.  This issue is corrected in the new release, but not for 
the corresponding case where API scripts reference ETABSv17.dll from ETABS v18. 

 222392 An incident was resolved for the Application Programming Interface (API) where the function 
SapModel.File.OpenFile would produce error and warning messages when opening some .e2k and 
.$et text files. 

 226841 An incident was resolved to correct an error in the documentation for the Application 
Programming Interface (API) where the sample code provided for the following four functions was 
incorrect and would generate an error if run: cPropArea.GetShellLayer Method, 
cPropArea.GetShellLayer_1 Method, cPropArea.SetShellLayer Method, and 
cPropArea.SetShellLayer_1 Method. The functions SetShell and AddQuick in the examples have 
now been replaced by "SetWall" and "AddMaterial" instead. This was a documentation error only. 
No results were affected. 

 226876 An incident was resolved for the Application Programming Interface (API) where the functions 
cAnalysisResults.JointDrifts and cAnalysisResults.StoryDrifts were returning drift results that were 
converted for length units, when in fact the returned results should be dimensionless.  Results for 
these values presented in the tables were correct, and no other results were affected. 

 229109 An incident was resolved for the Application Programming Interface (API) where the input 
arguments dx, dy, dz for the function cEditGeneral.Move were not being converted for the present 
units as specified through the API, but instead were always applied as being given in database 
units. 

 239662 An incident was resolved for the Application Programming Interface (API) in which the function 
GetLateralBracing would always fail and return a value of 1. 

 239653 An incident was resolved for the Application Programming Interface (API) where the function 
cPropRebar.GetNameListWithData did not convert the diameter and area parameters to present 
units. Instead the values were returned in the database units used when the model was first 
created or imported. 

 239872 An incident was resolved for the Application Programming Interface (API) where the function 
cJointObj.GetPanelZone always returned an error code of 1 for joints that had a panel zone 
assigned to them. 
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Documentation 
Incidents Resolved 

* Incident Description 

 217119 
224671 

A documentation error has been fixed for ACI 318-14 shear wall boundary zone design where the 
limit specified in ACI 318-14 equation 18.10.6.2(a) should be greater than 0.005 while previously it 
was documented as less than 0.005.  Similarly, ACI 318-11 equation ACI 21.9.6.2(a) should be 
greater than 0.007 while previously it was documented as less than 0.007.  These were only 
documentation errors and design results were not affected. 

 220507 An incident was resolved where the code examples in the API (Application Programming Interface) 
documentation for functions cDesignConcrete.GetSummaryResultsBeam and 
GetSummaryResultsColumn used incorrect syntax and hence could not be run when implemented 
in a client application.  The examples have been updated to run correctly.  The behavior of the 
software has not been changed. 

 219067 An incident was resolved where the EC3 2005 Steel Frame Design manual was missing Chapter 10, 
which contained all the seismic provisions.  This has been corrected.  This was a documentation 
error only, and no results were affected. 

 221187 The documentation for API (Application Programming Interface) function 
cFrameObj.SetLoadDistributed has been corrected for the definition of argument Dist2.  The 
correct definition should be the distance from the I-End of the frame object to the end of the 
distributed load.  Previously it referred to the distance from the J-End of the frame object to the 
start of the distributed load.  The behavior of the function was correct and consistent with the now 
revised description. 

 208934 A documentation error has been fixed for Section 2.2 of the concrete frame design manuals for ACI 
318-14, ACI 318-11 and ACI 318-08 codes.  Section 2.2 now clarifies that parameters for Special 
Seismic Load Effects are specified in the concrete frame design preferences instead of the Define 
menu.  This was a documentation update only. 

 217089 Documentation for superseded design codes AS 360-2001, CSA A23.3-04, and Hong Kong CP 2004 
have been removed from the RC and PT slab design manuals. 

 216872 The Help topic “Line Springs (Form: Frame Assignment - Line Springs)” was updated to indicate 
that compression-only line springs apply to horizontal and vertical frame objects, not just vertical 
frame objects as previously stated. 
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